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Message From  
The Editor 
	Jude Gaal
 CAREER COUNSELLOR / WORKSHOP FACILITATOR
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 INSPIRATIONAL QUOTE

With winter firmly entrenched for the next few months 
many of us may be whiling away the time by looking 

at seed catalogues or perhaps checking out vacation deals to 
warmer climates. Some of us may be plowing through that 
list of books placed on the back burner this past summer. 
And some of us may be in job search mode or exploring new 
occupations in anticipation of a career change. As we move 
further into 2018, the staff at Osborne Village Resource Centre 
has noticed the continued need for services by mature workers. 
The reasons for mature individuals seeking employment have 
not changed. Wanting to stay busy and productive while 
earning a little money on the side is one significant factor. 

With company pension plans becoming an increasingly rare 
benefit, another is the need to survive. 

In this Winter issue, the staff at OVRC continue to focus on 
the mature worker. Career counsellor Kristina Lonstrup offers 
insight as to how we may be part of the problem and how 
we can become part of the solution in What YOU Can Do To 
Prevent Ageism In The Workplace. Employment facilitator 
Betty Punkert provides the second installation in her three-
part series on computers, 7 2010, 10, 365, 8 What Do All These 
Numbers Mean Anyway!? 

Employment facilitator Lisa Elmhurst’s contribution, Working 
From Home, New Job Opportunities, brings attention to a variety 
of jobs in numerous sectors that may be just the ticket not only 
for mature workers but also for those individuals dealing with 
limitations. Kristina Lonstrup’s Dear Career Counsellor column 
offers an alternative to asking “Are you hiring?” that is sure to 
generate positive results. And Keith Robinson, our executive 
director, provides details on some upcoming changes at OVRC 
in his article OVRC Outlook – 2018.

We love your feedback, comments and ideas for articles, so 
send them to me, Jude Gaal at jgaal@ovrc.ca. Don’t forget to 
include in the Subject Line – Winter Newsletter.  

Cheers to the rest of winter.

A child has no trouble 
believing the unbelievable, 
nor does the genius or  
the madman. It’s only  
you and I, with our  
big brains and our  
tiny hearts, who doubt  
and overthink and  
hesitate. 

“

Steven Pressfield, Do the Work

“
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OVRC Outlook – 
2018 
	Keith Robinson
 EXECUTIVE DIRECTOR

OVRC is always adapting to the changes in the recruitment 
cycle and most importantly our client needs. We always 

attempt new ways to deliver high-quality service to our 
clients efficiently. The more relevant job/career search tools 
that we can provide clients, the more we will be able to assist 
clients in improving their chances of success and fulfillment in 
their future work life. Last year the staff created and delivered 
more job search workshops* resulting in OVRC providing 440 
additional services for clients from the previous year in an 
eight-month period.

When you are looking for work or trying to figure out what 
you want to do next, it is normal to feel frustrated and think, “I 
don’t know what to do, or how to find meaningful employment 
successfully, or the career path that best suits my skills and 
abilities.” We have all experienced this feeling. To help clients 
OVRC developed another new service. This new service gives 
you the opportunity to call our Front Desk and ask to speak 
with career counsellor Kristina. Think of Kristina as that voice 
on a GPS. You provide her with input–where you are now, 
where you want to be, and the frustrations you are presently 
experiencing. To help you get to where you want to be, she 
will ask questions to uncover your specific needs and suggest 
services designed to improve your chances of success. 

We know from experience that each client is unique. While 
one client may choose to participate in all of our services, 
another client may only choose one service that is most 
important to their success.  At OVRC you can pick and choose 

from the services that fit your needs. You are in control of your 
job search and choose from OVRC’s smorgasbord of services 
that fit your needs. Best of all, you won’t waste time with 
services that don’t suit your unique needs.

At the end of 2017, I had to make a very difficult decision that 
led to another change in the services OVRC offers. Since the 
start of this new year, OVRC no longer offers MS Word and 
MS Excel computer classes. I started my career at OVRC as 
an instructor of the classes. Betty, our most recent computer 
instructor, was my volunteer assistant before teaching the 
classes herself for the past three years. In that time we have 
both had the privilege of teaching many clients that have 
touched our hearts. The computer classes also provided many 
volunteers with the opportunity to gain work experience and 
skills that helped them achieve success in their career paths. 

The great news is that we are now able to book more resume 
appointments for clients and that Betty will again be teaching 
computer skills later this year. The new computer classes will 
focus on job search skills like internet job search, email, applying 
online, and MS Word skills to create job search documents 
like resumes, cover letters and a references page. With these 
skills, clients will have more control over their job search and 
potentially decrease the time it takes to get that next job. 

Luckily a few things never change. One is the amazing team 
at OVRC and their dedication to the success of our clients. 
Another is the support of our talented Board. We would not 
be here without their quiet work in the background. Thirdly, 
and most important, are our clients. It is your hard work that 
continues to provide OVRC with the success that we get to 
share with our funders.

To learn more about OVRC, check out our website at www.
ovrc.ca for a description of all the services and workshops 
offered. And don’t forget to read the valuable client feedback 
to learn how OVRC’s services have made a difference in their 
job search and career exploration. You can also learn more 
about our Board members by clicking on About Us and 
going to Board of Directors. Finally, stay safe and warm until 
we meet back here in the spring. 
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Dear Career Counsellor:

I have been searching for a job as a seasonal retail customer 
service clerk so I can earn some extra income over the holidays.   
I have found this to be more challenging than I expected.  When 
I go into a store with my resume, and I ask “Are you hiring?”, I find 
that I am not getting positive answers.  Some stores don’t even 
take my resume.  Is there something better I could be doing?

Thank you for your help.

Sincerely,

L.M.

Winnipeg

Dear L.M.,

The method of going to a store with a resume and asking “Are 
you hiring?” comes with challenges. 

Consider these perspectives:

The question “Are you hiring?” puts the employee on the spot.  
By asking “Are you hiring?” what you are asking is a question 
that is followed by a “yes” or “no” response.  

By saying “Yes,” the employee may feel that he or she is 
misleading you. Remember, the employee, or the manager, 
hasn’t yet had a chance to learn anything about you: your work 
history, your employment expectations, your attributes, or your 
work ethic.  If an employee says “Yes,” you may get your hopes 
up to for overly eager expectations:  the manager may not be 
able to accommodate you in the end, and secondly, you might 
be tempted to put the brakes on your job search if you think this 
one store is a sealed deal.

By saying “No,” the employee or manager may not want to lead 
you on to false promises.  Perhaps the employee or manager 
isn’t the one responsible for hiring.  Perhaps the employee or 

Dear Career 
Counsellor  
	Kristina Lonstrup
 CAREER COUNSELLOR 

manager is busy; he or she might not have the time to explain 
the ins and outs of how he or she hires, even if there is a potential 
employment opportunity. 

Try this instead:

If the store you are visiting is a store that excites you and 
intrigues you, TELL THEM.  Start off by saying “I love this store.”  
Immediately you are expressing your potential enthusiasm, 
energy, and commitment.  You are validating the employees’ 
work-life by making them feel successful and wise.  Think about 
it:  how would you feel if someone told you they love where 
you work?

Next, say “What kind of advice would you give to someone who 
wants to work here?”  This question is a strategic approach.  It 
encourages a better response than a one-word reply (“Yes” 
or “No”).  Asking for advice will get the employee talking 
more, which can potentially turn into a conversation.  With 
conversation, you have the opportunity to build rapport.  

Before going into a store, ask yourself these questions:

1. What is it about this store that I enjoy so much?

2. Why am I a good worker?

3. How do I see myself as an employee at this store?

4. What is my availability?

By answering these questions, you will have the vocabulary 
ready to express your enthusiasm and commitment.  You will 
be introducing yourself as curious and eager, without putting 
the employee on the spot.  By asking an open-ended question, 
it creates a more comfortable atmosphere to engage in positive 
interaction. 

Try this out!  And good luck in your search!

Kristina Lonstrup 
Career Counsellor

The question “Are you hiring?” can often put an employee on the spot.   
Try a different approach instead!

OSBORNE VILLAGE RESOURCE CENTRE  Winter Newsletter 2017-2018
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Using age-appropriate language in the workplace is 
EVERYONE’S responsibility.  

Unintentional ageist language is more damaging than 
you may realize.  What may seem like a casual passing 

comment to you, may be internalized by the recipient deeper 
than you may believe.  Here are some thoughts to consider to 
ensure that the age-appropriate language you are using in the 
workplace is healthy and respectful. 

1. Beware of “elderspeak”. Never think that because a 
person is older, they are to be coddled.  Do not refer to 
older women as “honey” or “sweetie”.  Do not refer to older 
men as “Young Man”.  This is condescending and creates 
an imbalance of equality and respect.  Describing an older 
person as “young” is not a compliment—it draws attention 
to an issue that you are implying is an inadequacy. 

2. Beware of stereotypes. Never assume that because 
a person is older, he or she lacks the skills necessary to 

complete the job.  Remember that this person has had 
decades of life experience, including challenges, setbacks, 
problem-solving opportunities, and technological 
advances.  

3. Recognize work ethic. Acknowledgement energizes 
everyone, everywhere, but unfortunately, many people 
have to be reminded to express appreciation.  Take time 
to acknowledge punctuality, commitment, dedication, 
and competence in mature workers—you may not be 
aware that an extra boost of confidence is extremely 
empowering.    

4. Respect chapters in life. Be careful not to assume that 
aging equals unhappiness.  Different cultures celebrate 
life chapters differently and we could all learn from this 
perspective.  

5. Don’t call them “senior moments”.  If you have forgotten 
something, or are having a hard time reading something, 
do not complain that this is a sign of aging.  Changes in 
vision and random forgetfulness happen to everyone at 
all times.  By complaining that you are having a “senior 
moment” creates a generalization that older people 
struggle in life.  

While you may think that you are treating a mature worker 
kindly by giving pet names or unsolicited sympathy, your 
language could actually be harmful.  Ensure that you are 
promoting autonomy and respect.  Be aware of how your 
language affects others.  

Source:  Magan, Geralyn.“The Power of Language to Change How 
We View Our Aging Selves.” www.leadingage.org, 2017.

What YOU Can Do 
To Prevent Ageism 
In The Workplace 
	Kristina Lonstrup
 CAREER COUNSELLOR 

“When you say someone has a 
young spirit, young is not what 
you mean.  You really mean 
that the person is engaged, 
lively, energetic, or healthy.  
But the message that comes 
across—and the message that 
the person internalizes—is that 
young is good and old is bad.”

- Dr. Tracey Gendron

OSBORNE VILLAGE RESOURCE CENTRE  Winter Newsletter 2017-2018



7, 2010, 10, 365, 8: What Do All These 
Numbers Mean Anyway! 
	Betty Punkert 
 EMPLOYMENT FACILITATOR

Welcome back to the second of a three-part series that 
will attempt to demystify the Windows versus Office 

confusion and help you identify which version you have, and 
what its advantages and disadvantages are. 

Microsoft Office is a collection of application software that allows 
you to perform certain business-related tasks such as editing 
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Working From 
Home, New Job 
Opportunities 
	Lisa Elmhurst
 EMPLOYMENT FACILITATOR

Most companies will provide training. However you will 
need a computer, access to the internet, Microsoft Software, 
a telephone, and depending on the kind of work, a typing 
speed of a minimum of 45 wpm or more is necessary. Many 
employers also require sales, customer service and strong 
communication skills, as well as the ability to manage your 
own time and meet deadlines. 

If the working from home is a good option for you, go online 
and investigate the job titles that most appeals to you. 

Until recently, working from home was once unheard 
of unless you were an artist or a music teacher. Today 

there is good news for the homebodies of the world, or 
those who dislike the rush hour commute, or for those 
who have limitations, or for mature workers who want to 
continue working. If you are comfortable using a computer 
and navigating the internet, there is a new world of work 
possibilities that may even include a company pension, 
medical and other company benefits.

There are now different job options available in the financial, 
educational, technology, hospitality and customer service 
sectors. Curious to know what kind of jobs? Job titles, found 
the internet, include Online English Language Teacher, 
ESL Teacher, Interpreter, Online Instructor, Travel Agent, 
Customer Service Representative, Bilingual Customer Service 
Representative, French Bilingual Corporate. If none of those are 
of interest you can always check out Travel Reservation Agent, 
Remote Call Centre Agent, Social Media & Content Specialist, 
Customer Solutions Expert, Administrative Assistant/
Receptionist, Tech Services Specialist, Web Programmer and 
Personal Care Specialist.

“If you are comfortable using a 
computer and navigating the 
internet, there is a new world of work 
possibilities that may even include 
a company pension, medical and 
other company benefits.”

OSBORNE VILLAGE RESOURCE CENTRE  Winter Newsletter 2017-2018

documents and creating spreadsheets. If Windows is the brain, 
think of Office as the arms and legs, since a brain can’t hold a 
pen or move around without help. Images used are from Word, 
but Office also contains Excel and PowerPoint.  Depending on 
the version, it may also contain One Note, Outlook, Publisher 
or Access. 
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Pre-Ribbon – Office 97, 2000, 2003 (No Longer Available)

These early versions of Office relied heavily on hidden away 
menus for special features such as chart creation and mail 
merge that were hard to find. The majority of the buttons have 
been the same for basic formatting through every version of 
Office, even the ones with the Ribbon introduced later, so Bold 
is still a black B, and Italics is still a tilted I.

Ribbon Introduced – Office 2007

Office 2007 was released in 2007 and introduced the Ribbon 
toolbar. The biggest two issues with Office 2007 are as follows: 

1. The Office logo replaced the File menu, confusing people 
who were used to that terminology.

2. The tabbed menus of the Ribbon allow easier access to lesser 
used functions such as mail merge, clip art and creating 
tables. 

The Home tab will always contain the most used functionality 
of the application, just like the old Standard and Formatting 
toolbars in previous versions. 

Return Of The File Menu – Office 2010

Microsoft listened to the confusion of its customers when it 
released Office 2010 and reinstated the File menu. The File 
menu is colour coded to the application you are using – blue for 
Word, green for Excel, orange for PowerPoint and so on. 

Office 2010 is what we use at OVRC, but you’re not going to be 
able to buy a copy in store or online. Office 2013 looks similar 
enough that if you learn 2010, you should be able to use 2013 
with very little difficulty.

Touchscreen-Friendly; Subscription Option – Office 2013/
Office 365

Because of the focus on touchscreen-friendly design from 
Windows 8, Microsoft simplified Office 2013’s buttons and 
appearance even further. They added a new Design tab, 
intended to simplify the addition of features like watermarks 
and document themes. There are a few things that are renamed 
or moved (e.g. ClipArt is now called Online Pictures, and the 
removal of the ruler button from the scrollbar).

Introduced with Office 2013 was the subscription version of 
Microsoft Office, called Office 365. Like Windows 10, Office 365 
is Software as a Service, but unlike Windows which you pay only 
once for, Office 365 has an annual fee.

• Which should you buy? The $150 Office 2013 (or 2016)? The 
$70/year 365 single license? The $100 365 multi license? It 
depends:

 o For most people who only use the software on one  
 system, the $150 single user version is probably your  
 best deal since Microsoft Office only seems to come out  
 with new versions every three years or so, which is $50/year. 

 o If you have multiple computers ($100/year for five licenses),  
 or you want to make sure you get the upgrades ($70/year  
 for one license), consider the subscription. 

 o Be aware, if you do not pay the subscription fee, your  
 software stops working, so this is going to be an annual  
 charge on your credit card!

You do not purchase physical media, you buy a card with a 
license key and then download the application from Microsoft’s 
servers. 

Office 2013 began to aggressively integrate online functionality, 
in particular, the ability to save documents in the cloud using 
an Outlook or Hotmail account with its associated OneDrive 
storage. 

Colour-Coded Title Bars – Office 2016/Office 365

Office 2016 has replaced the coloured File tab with a coloured 
title bar, making it much easier to see what program you are 
currently using. It has also integrated Cortana search capability 
into its help function (“Tell me what you want to do…” search 
bar). Otherwise, it is much the same as Office 2013/Office 
365. If you were an Office 365 subscriber, the newest version 
upgraded automatically.

And there you have it. To help you remember which is which, 
remember that Windows has version numbers (7, 8, 10) and 
Office has the year the software was released (2010, 2013, 
2016). 

Happy computing!

Pre-Ribbon – Office 97, 2000, 2003 (No Longer Available) 

Ribbon Introduced – Office 2007

Return Of The File Menu – Office 2010

Touchscreen-Friendly; Subscription Option – Office 2013/Office 365

Colour-Coded Title Bars – Office 2016/Office 365
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About OVRC’s Newsletter
If you have an idea for an article you would like to see, or contribute to the newsletter, 

 or have any comments or suggestions, please contact: 

Newsletter Editor Jude Gaal, at 204.989.6503 or jgaal@ovrc.ca
Newsletter design and layout by our volunteer Kristin McPherson.

About OVRC 
Do you need help preparing a resume or cover letter?

Could you benefit from meeting with a career counsellor, 
or signing up for our career and employment workshops?

To maximize your path to meaningful employment, go to OVRC’s website at:

www.ovrc.ca
For information on the free employment workshops and services available

call Judy, our client services representative, to schedule an appointment
and /or sign up for one or all of our workshops.

Tel: 204.989.6503

If you would like to receive OVRC’s Newsletter by email  
contact us at 204.989.6503 to get onto our mailing list.




